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Aim

This tutorial is designed to introduce the reader to the available GPlates
rasters, and how to use them, in combination with reconstruction tools
such as flowlines and motion paths, to explore possible tectonic histories.

Included Files

Click here to download the data bundle for this tutorial.
The tutorial dataset
(3.4-Incorporating_Raster_and_Vector_Constraints.zip) includes the
following files:

GPlates project file: Tutorial_3.4.gproj

Free Air Gravity Anomaly Raster files:
● Free_Air_Gravity_Anomalies_Legend.jpg
● Free_Air_Gravity_Anomalies.gpml
● Free_Air_Gravity_Anomalies.jpg

Global Geology Raster files:
● Global_Geology_Legend1.png
● Global_Geology_Legend2.png
● Global_Geology.gpml
● Global_Geology.png

Feature Collections Directory (loaded in the project file by default):
● Rotation File:

○ Muller_etal_2019_CombinedRotations.rot
● Static Polygons:

○ Muller_etal_2019_Global_StaticPlatePolygons.gpmlz
● Plate Boundaries and Topologies:

○ Muller_etal_2019_PlateBoundaries_DeformingNetworks.gpmlz
● Rasters:

○ Muller_etal_2019_PresentDay_AgeGrid.gpml
○ Topography.gpml

● Coastlines:
○ Muller_etal_2019_Global_Coastlines.gpmlz

Background

The GPlates sample data provides users with a number of colour,
numerical and time-dependent rasters, which display present day features
of the crust, from crustal strain, to free air gravity anomalies. As
explained in previous tutorials (3.1 and 3.2), these can be ‘cookie-cut’
according to the present day plate geometries, and reconstructed back
through time.

https://www.earthbyte.org/webdav/ftp/earthbyte/GPlates/TutorialData_GPlates2.2/3.4-Incorporating_Raster_and_Vector_Constraints.zip


In this tutorial we will be investigating the evolution of the Indian Ocean,
which began formation during the Cretaceous, following the break up of
East Gondwana (Gibbons, 2013).

Before we begin visualizing and exploring some of the available rasters, it
may be helpful to understand the difference between the three types of
raster files:

● Colour raster – a simple 2-dimensional grid of pixels stored as
JPEGs or grid files, where each pixel has a colour assigned to it. The
majority of the rasters come in this format.

● Numerical raster - this is similar to a colour raster, however each
pixel/cell has a numerical value assigned to it. These values are
used to generate a colour raster, and as such, the colour scale can
be changed, unlike colour rasters.

● Time dependent raster –a series of rasters which have been
age-coded so we can observe the evolution of a dataset through
time.

Exercise 1 – Evolution of the 90 East Ridge

The 90 East Ridge is a linear, age-progressive plume trace, located in the
eastern Indian Ocean, and as its name suggests, strikes almost parallel
with the 90° E meridian (Figure 1). It has been referred to as a ‘leaky
transform’, perhaps resulting from the interaction of a transform fault with
the Kerguelen plume, which first erupted 117 Ma forming the Rajmahal
Traps (O’Neill, 2005). The ridge therefore displays an age progression, but
not one as simple as an intra-plate chain like the Hawaiian-Emperor
volcanic chain displays. The Kerguelen plume appears to have a
complicated history and remains active today, driving the volcanism we
see on Heard and McDonald Islands located on the central Kerguelen
Plateau (O’Neill, 2005).



Figure 1. Left: The Indian Ocean as depicted by the ‘Topography’ raster, indicating the
locations of the 90 East Ridge and Kerguelen Plateau. Right: Gravity map of the
Kerguelen hotspot system indicating the age progression across the Plateau and Ridge
(from O’Neill et al., 2005).

In this exercise, we will visualize the 90° East Ridge using the ‘free air
gravity anomalies’ and ‘global geology’ rasters, and trace its evolution
using both flowlines and motion paths. This will highlight the difference
between absolute and relative motions and the nature of seafloor fabrics.

(N.B. You may notice in some of the figures that the polylines
representing the motion path, flowline or plate boundaries appear thicker
than they will on your GPlates globe. This has been done to aid with
identification. For an explanation of how to do this, refer to Exercise 2)

1. Open GPlates and load in the GPlates project file included in the
tutorial data bundle (Tutorial_3.4.gproj), either using File → Open
Feature Collection or by dragging and dropping the file onto the
globe.

2. Rotate the globe so that the Indian Ocean is in view (Figure 2).



Figure 2. Orientation of the globe with Indian Ocean in view

3. If it is not already visible, bring up the Layers window (Window →
Show Layers or Cmd/Ctrl+L).

Notice that the ‘Topography’ raster is visible (as indicated by the
symbol). This layer is red, indicating that it is a raster layer.

See if you can locate the 90° East Ridge and the Kerguelen Plateau. You
can also try reconstructing back in time by either entering a time into the
dialog box or using the slider and arrows. Can you get an idea of how the
90° East Ridge formed in relation to plate boundaries?

4. Now locate and load the raster file
‘Free_Air_Gravity_Anomalies.gpml’ by dragging and dropping the
file onto the globe or load the .jpg with the same name using File →
Import → Import Raster… and click ‘Yes’ when asked if you would
like to open the existing GPML file. Your globe should now look like
the one in Figure 3 (if it does not, try dragging the
Free_Air_Gravity_Anomalies layer above the Topography layer in
the Layers window).

This provides us with another way of visualizing the crust, in this case,
using free air gravity anomalies. Can you still locate the 90 East Ridge?
The relative thickness of the ridge compared to the surrounding ocean
crust gives it its positive gravity anomaly, which allows us to identify it.



Figure 3. View of the 90 East Ridge, as seen in the free air gravity anomalies raster.

5. Expand the red ‘Free_Air_Gravity_Anomalies’ layer in the Layers
window by clicking the little black triangle on the left.

6. In the “Inputs” section of the layer, click on the “Add new
connection” button under “Reconstructed Polygons:” and select the
static polygons file from the list
(Muller_etal_2019_Global_StaticPlatePolygons). Under “Age grid
raster:” again click on the “Add new connection” button and select
the seafloor age grid file (Muller_etal_2019_PresentDay_AgeGrid).
These layers should have been loaded with the project file.

Figure 4 displays how your layers window should look after making these
changes.



Figure 4. Layers window displaying changes made in Step 6

This raster has now been cookie-cut according to the plate polygons,
allowing us to reconstruct it back in time. Use the slider to see for
yourself. For more information on how this is done refer to Tutorial 3.2:
Rotating Rasters and Age-Based Masking of Raster Data. Note that you
can continue this tutorial with whichever raster you prefer displayed, but
while constructing the flowline and motion path, this tutorial will have the
topography raster visible.

7. Hide the ‘Free_Air_Gravity_Anomalies’ raster so that the
‘Topography’ raster below it is once again visible (Figure 5).



Figure 5. Layers window displaying changes made in step 7

It’s now time to construct a flowline and a motion path to track the
evolution of the 90° East Ridge. For detailed explanations of these tools
refer to Tutorial 2.3: Flowlines and Motion Paths.

Let’s begin with the flowline. Flowlines are half stage rotations calculated
by GPlates based on the rotation file you are using. They track the
relative plate motion away from spreading ridges. In the real world, these
develop as features such as fracture zones.

8. Zoom in to focus on the Indian Ocean (Figure 6).

Figure 6. View of the Indian Ocean, Kerguelen Plateau and 90° East Ridge.

9. Select the Digitisation workflow tab and the Digitise New

Multi-point Geometry tool from its submenu. Use this to create



a new seed point located on the spreading ridge between the
southern tip of the ridge and the plateau (refer to Figure 7).

Figure 7. The location of the seed point you will use to construct the flowline is marked
with a red star.

10. Once you are happy with the location of your point, click on the
“Create Feature…” button on the right side of the globe. This will
open up the Create Feature menu.

11. Choose your “Feature Type” to be ‘Flowline’ (Figure 8) and click
“Next”.



Figure 8. Create a Feature menu with ‘Flowline’ highlighted.

12. This window allows you to fill in the properties of your point.
Leave the ‘Interpret provided geometries’ option as Spreading
centre(s). Under ‘Common Properties’, fill in the following fields
(Figure 9):

○ Left Plate ID: 511 (Central Indian Basin)
○ Right Plate ID: 802 (Antarctica)
○ Begin (time of appearance): 83 Ma
○ End (time of disappearance): select ‘Distant Future’
○ Name: 90 East Ridge Flowline

Click “Next”.



Figure 9. Create Feature menu – flowline properties.

13. In the new menu which appears, under ‘Available Properties’
select gpml: times and click “+ Add”.

14. A new menu will pop down. Under ‘Insert multiple times’, fill in
the following values:

○ From: 83 Ma
○ To: 0 Ma
○ in steps of: 10 Ma

Then click “Insert” (Figure 10).
Click “OK”



Figure 10. Create Feature menu – inserting time steps.

15. Select “→ Next”

16. Choose ‘<Create a new feature collection>’ then click “Create”.

A coloured flowline will have appeared (Figure 11). The arrows indicate
the direction of plate motion at the time it appears, with a yellow point
indicating the position of the spreading ridge. You should see that the
green half of the line flows parallel to the fracture zones as it moves
northeast away from the spreading center, and then turns and follows
directly along the 90° East Ridge. This alignment suggests that the plume
feeding the ridge was interacting with the plate boundaries related to the
Indo-Australian-Antarctic triple junction, as it formed (Whittaker et al,
2013).



Figure 11. Flowline following the 90° East Ridge.

Experiment with reconstructing the flowline back in time. If you use the
slider or arrows to move forward in time, you will see the flowline as it is
created. You may notice that between 83 Ma and 40 Ma the yellow seed
point is not constrained to a plate boundary. This is because the spreading
ridge on which we set it has not yet formed. If you set the time to 54 Ma
and play forward, you will be able to see the formation of the ridge
following the fracture zone associated with the India-Australia Mid Ocean
Ridge (Figure 12).



Figure 12. Time progression (55–40 Ma) showing the interaction of the 90 East Ridge
with a fracture zone. The flowline is in lime green and plate boundaries are shown in red.

17. At this point you may like to save your flowline. Click on the
symbol in the bottom right hand corner of the screen. This will bring
up the ‘Manage Feature Collections’ window. Scrolling to the bottom
of the list of feature collections you will see a layer called ‘New
Feature Collection’, highlighted in orange, this is the flowline you

just created (Figure 13). For this layer click the ‘Save As’ icon ,
under ‘Actions’.

Figure 13. Manage Feature Collections window.



18. Navigate to the tutorial data folder and save your flowline with
an appropriate name such as ’90 East Ridge Flowline’. Keep the
default file extension .gpml. Then click “Save”.

19. You may also like to make visible the ‘Free Air Gravity’ raster we
uploaded previously as an additional way to visualize the ridge
formation.

Now we will compare our flowline, which uses relative motions, with a
motion path that will reveal the absolute motion of the volcanic trace
relative to the mantle. Motion paths can be used to track the absolute
motion of surface features formed by mantle plume hot spots. Comparing
the generated path produced by the rotation file to the actual hotspot
track can give you a clue as to other tectonic processes that may be
interacting with the plume, confusing the plume trace and age
progression.

20. As was done for the flowline, create a seed point, but this time
place it on the northern region of the Kerguelen Plateau (Figure 14).

Figure 14. The location of the seed point used to create the motion path is marked with
a red star.

21. Once you are happy with its location, click “Create Feature…” in
the bottom right hand corner.

22. This time choose your “Feature Type” to be ‘MotionPath’ and click
“Next”.



23. Under ‘Common Properties’, fill in the following fields (Figure 15):
○ Plate ID: 0 (this is the mantle)
○ Relative Plate ID: 511 (Central Indian Basin)
○ Begin (time of appearance): 83 Ma
○ End (time of disappearance): select ‘Distant Future’
○ Name: 90 East Ridge Motion Path

Click “Next”.

Figure 15. Create Feature menu – motion path properties.

24. The ‘gpml:times’ property we created for the flowline should
automatically be included as part of the ‘Existing Properties’ list. If
not, follow the same process outlined in steps 13 and 14.

25. Click “Next”, select ‘<Create a new feature collection>’ then click
“Create”.

26. A light blue motion path should now have appeared (Figure 16).



Figure 16. Display of globe showing newly created motion path (yellow) and previously
created flowline (dark blue and lime green) at 0 Ma. Plate boundaries are outlined in red.

27. Take the time to save this feature as we did for the flowline,
using an appropriate name, such as ’90 East Ridge Motion Path’.

Time for one last piece of evidence to help us visualize the evolution of
the ridge:

28. Locate the ‘Global_Geology.gpml’ file in the tutorial data bundle
and drag it onto the globe (Figure 17).



Figure 17. Globe displaying the ‘Global_Geolgy’ raster at 0 Ma.

This raster displays a range of geological features from major rock facies
to glacial extents and large igneous provinces (LIP). Have you noticed
that the 90° East Ridge and Kerguelen Plateau (coloured red) are formed
from a different rock type than the surrounding sea floor? See if you can
locate these rock facies in the legend for this raster (the legend is
comprised of two images, included in the data bundle). They are defined
as oceanic LIP plateaus, which tells us that they are of volcanic origin.

29. Expand the ‘Global_Geology’ layer. In the “Inputs” section, click
on the “Add new connection” button under “Reconstructed
Polygons:” and select the static polygons file
(“Muller_etal_2019_Global_StaticPlatePolygons”) from the list.
Under “Age grid raster:” again click on the “Add new connection”
button and select “Muller_etal_2019_PresentDay_AgeGrid”. Figure
18 displays how the layer should look after making these changes.
This will allow us to reconstruct this layer back through time.



Figure 18. How your ‘Global_Geology’ layer should look after completing step 29.

We now have three different rasters loaded to help us visualize the 90°
East Ridge and Kerguelen Plateau, and both a flowline and motion path to
help track their evolution.
Set the time to 83 Ma and reconstruct through to present day. Watch how
the development of the flowline and motion path varies, resulting in quite
dramatic differences at present day.

Can you see that the motion path, which is using absolute motions
relative to the mantle, has the worst fit with the ridge? This suggests that
the mantle plume has either moved (as a result of mantle wind or the
splitting of the plume into a number of diapirs) or that there has been
preferential upwelling of the magma along the plate boundaries.
Whittaker et al. (2013) found that a fixed hotspot reference frame
produced the best match between the reconstructed position of the 90°
East Ridge and the inferred track of the plume, suggesting that
preferential upwelling is the most plausible explanation of the differences
we see in the relative and absolute hot spot paths we created.

Keep GPlates and your generated flowline and motion path open for
Exercise 2.



Exercise 2 – Exporting Projected Geometries & Rasters

This short exercise follows on directly from Exercise 1 and explains some
of the ways that you can export and visualize the rasters and projected
geometries.

1. You should still have GPlates open and your files loaded from
exercise one. If not, open GPlates and drag and drop the GPlates
project file ‘Tutorial_3.4.gproj’ from the data bundle onto the globe.
The files in this project will be sufficient to complete the exercise,
but note that figures will look different, as you will have the
topography raster displayed.

2. Rotate the globe and zoom in so that you are focused on the 90°
East Ridge (Figure 19). Your motion path and the northern segment
of the flowline should be visible.

Figure 19. Globe focused on the 90° East Ridge with the Global_Geology raster visible.

3. Navigate to the ‘Export’ window using: Reconstruction →
Export…(Figure 20).



Figure 20. Step 3.

4. At the top of the window that appears, you are given two options:
○ ‘Export Time Sequence of Snapshots’
○ ‘Export Single Snapshot Instant’

We are going to begin by exporting a single snapshot, so select this
option. The window should now appear as it does in Figure 21.



Figure 21. Options for exporting a single snapshot.

5. Make sure the time is set to 0 Ma.

6. Click the button and a new window should appear. Choose
the following options (Figure 22):

○ Select ‘Projected Geometries (and Rasters)’
○ Choose the output file format ‘SVG (*.svg)’
○ Under ‘Image Resolution’, use the main window dimensions by

clicking on the button.
○ Add more detail to the default name given under ‘Template:’.

For example you might use ‘snapshot_90EastRidge%0.2fMa’.



Figure 22. ‘Add Data to Export’ window with options selected.

7. Click ‘OK’

8. A new row of data, highlighted in dark blue should have appeared in
the ‘Export Data’ section. The next step is to specify your target
directory by clicking and navigating to the folder you would like
to save it in, perhaps the tutorial data bundle folder. Click ‘choose’.

9. Now you are ready to export. Click:

10. The SVG file you have produced will now allow you to manipulate
and edit the snapshot. For example, loading the file into Adobe
Illustrator will allow you to select individual lines and increase their
thickness. A very brief illustration of this is given in Figure 23. Refer
to specific tutorials for Adobe Illustrator on more information on
how to do this.



Figure 23. Increasing the thickness of the exported lines using Adobe Illustrator.

11. We are now going to export a time sequence of snapshots. The
‘Export’ window should still be open, if not, open it using:
Reconstruction → Export…

12. Select the ‘Export Time Sequence of Snapshots’ option (Figure
24).

13. Zoom out so that the entire globe is in view, still focused on the
Indian Ocean (Figure 24)



Figure 24. By Step 13 you should have your entire globe visible, focused on the Indian
Ocean, and the ‘Export’ window open and ready to input variables.

14. In the ‘Export’ window under ‘Time Range’, set the following
times:

○ Animate from: 83 Ma
○ to: 0 Ma
○ with an increment of: 1 Ma

15. Click , and in new window that appears, select the
following for each of the steps (Figure 25):

○ Select ‘Image (screenshot)’
○ There are a number of good options, but in this tutorial we

will select ‘Portable Network Graphics (*.png)’ as the file
format.

○ Under ‘Image Resolution’, use the main window dimensions by
clicking on the button.

○ Add more detail to the default name given under ‘Template:’.
For example you might use
‘Indian_Ocean_Reconstruction_%0.2fMa’. The ‘%0.2f’ ensures
that each file is labeled with the correct reconstruction time.



Figure 25. Step 15.

16. Click ‘OK’

17. A new row of data should have appeared in the ‘Export Data’
section. The next step is to specify your target directory by clicking

and navigating to the folder you would like to save it in. It is
best to create a new folder for this step, as 83 files will be
produced. Once you have navigated to the desired folder, click
‘choose’. Your export window should look as it does in Figure 26.



Figure 26. Step 17.

18. You are now ready to export the snapshots. Click: .
Generating the files will take a few seconds.

19. In the selected folder you should now see a .png file for each
time step (Figure 27 gives an example for 20 Ma). These images
can be used to generate figures or combined to create an animation
showing the evolution of the Indian Ocean through time. This
tutorial will not go through this step, but some simple programs
that could be used to create an animation include: iMovie, Windows
Movie Maker, FFmpeg, Time Lapse Assembler…



Figure 27. PNG file showing the arrangement of continents around the Indian Ocean at
20 Ma, visualized using the Global_Geology raster. The motion path and flowline
constructed in the first exercise are also visible.
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